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Computer simulation has become an essential part of science and engineering. Digital
analysis of components, in particular, is important when developing new products or
optimizing designs. Today a broad spectrum of options for simulation is available;

researchers use everything from basic programming languages to various high-level
packages implementing advanced methods. Though each of these techniques has its
own unique attributes, they all share a common concern: Can you rely on the results?

When considering what makes software reliable, it's helpful to remember the goal:
you want a model that will accurately depict what happens in the real world. A
computer simulation environment is simply a translation of real-world physical laws
into their virtual form. How much simplification takes place in the translation process
helps to determine the accuracy of the resulting model.

It would be ideal, then, to have a simulation environment that included the possibility
to add any physical effect to your model. That is what COMSOL is all about. It's a
flexible platform that will allow even novice users to model all relevant physical
aspects of their designs. Advanced users can go deeper and use their knowledge to
develop customized solutions, applicable to their unique circumstances. With this
kind of all-inclusive modeling environment, COMSOL gives you the confidence to
build the model you want with real-world precision.

Certain characteristics of COMSOL become apparent with use. Compatibility stands
out among these. COMSOL requires that every type of simulation included in the
package has the ability to be combined with any other. This strict requirement
actually mirrors what happens in the real world. For instance in nature, electricity is
always accompanied by some thermal effect; the two are fully compatible. Enforcing
compatibility guarantees consistent multiphysics models, and the knowledge that,
even as the COMSOL family of products expands, you will never have to worry
about creating a disconnected model.

Another noticeable trait of the COMSOL platform is adaptability. As your modeling
needs change, so does the software. If you find yourself in need of including another
physical effect, you can just add it. If a one of the inputs to your model requires a
formula, you can just type it. Using tools like parameterized geometry, interactive
meshing, and custom solver sequences, you can quickly adapt to the ebbs and flows
of your requirements.

COMSOL Multiphysics also has several problem-solving benefits. When starting a
new project, using COMSOL helps you understand your problem. You are able to
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test out various geometrical and physical characteristics of your model, so you can
really hone in on the important design challenges. The flexible nature of the
COMSOL environment facilitates further analysis by making "what-if' cases easy to
set up and run. You can take your simulation to the production level by optimizing
any aspect of your model. Parameter sweeps and target functions can be executed
right in the user interface. From start to finish, COMSOL is a complete
problem-solving tool.

As you become a more experienced user of COMSOL, your confidence in computer
simulation will grow. You will become a more efficient modeler, and the results will
show it. The remainder of this introduction is dedicated to give you a strong start
toward this goal. After a general introduction to the user interface, several tutorials
will take you step by step through sample models that highlight important features.
The informative charts give you an idea of COMSOL's capability by associated files,
functions, and built-in options. By the end you will be well on your way to reaping all
the benefits that COMSOL has to offer
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COMSOL Multiphysics version 4 brings an unprecedented level of clarity to your
simulation work by giving you both an organized model overview and a streamlined
model-building process. The COMSOL user interface reduces clutter and redundant
tasks, so your attention can be focused on the substance of your design studies
resulting in increased productivity. Naturally COMSOL continues in its tradition of
powerful solvers and flexibility in physics, but it is the new user interface that stands
out the most.

The COMSOL Desktop helps you organize your simulation by presenting a clear
overview of your model at any point. It uses functional form, structure, and aesthetics
as the means to achieve simplicity for modeling complex realities. For instance,
task-specific tools appear on the Desktop right when you need them; showing only
the currently possible and necessary actions removes uncertainty from model
building and brings order to your simulations. The Desktop is made up of several
windows, which may or may not be displayed depending on the need. These
windows include the Model Builder, Settings, Graphics, Messages, Progress, Help, and
others.

Main Menu  Main Toolbar Settings Graphics Window

13 heat sinkmph - COMSOL Multiphysics =[5 [

Fie Edt Options Help
IzB8a8 B 4@ ~A 9atlh AEeaEdBS

"7 Model Builder ~ = 01| (3 Settings /[ @ = O)(ch Grphis

AE[ -z =@ (@ =0
@ Surface Temperature and Flow Field c
Data

Data set: From parent

I

Expression P

Coloring and Style

Caorabe
[ Color legend
[ Wireframe.
1@ 30 Plot Group 1 =
1) Surfacel Inherit Style
1 Messages 52 Progress| (] Results| =g
ion cowsoL o082
T 3D Plot Group 2
(77 Report
v E——
Model Builder with Model Tree Messages, Progress, and Numerical Results

Capture the Concept | 3



You can easily customize the layout of these windows on the Desktop to suit your
particular work habits: All windows can be positioned and sized in any way. They can
be detached from the Desktop and moved back and forth between computer
displays. These settings can be saved as preferences for the next time COMSOL
Multiphysics is opened.

Dynamic Help Model Builder and Settings

Model Library Material Browser Graphics Window

The version 4 user interface also streamlines the modeling workflow by introducing
the new Model Builder. Containing a Model Tree, the Model Builder does much
more than outline your model. It is a graphical programming environment that gives
you dynamic control of your procedures and simulations. By following along the
nodes within the Model Builder, you will experience a smoother, more direct, and
less cumbersome way to specify your models.



Have a look at a snapshot of the Model Builder; which comes from an example in a
later section.

7 Model Builder ¥ =0

4 % busbar.mph (root)
Global Definitions
' Model 1 {modl)
> = Definitions
a \F\ Geometry 1
> ,5:’ Work Plane 1 (wpl)
& Bxtrudel (extl)
> ,5:’ Work Plane 2 (wp2)
& Bxtrude 2 (extd)
> ,5:’ Work Plane 3 (wp3)
& Bxtrude 3 (ext3)
@] Form Union (fin)

m

4

-

. @8 Materials
> Joule Heating (jh) [
- oule Heating (jh) *5° Joule Heating Model
> Bz Mesh1 -
4 & Studyl “4  Electromagnetic Heat Source
|7 =Step 1: Stationary #8 Infinite Elements
> [Pre Solver Configurati¢ *5™  Initial Values
@ R?SUH:S Heat Transfer 3
- i Data Sets .
B2 Derived Values Electric Currents 3
Tables * Periodic Condition
- [l 3D Plot Group 1
Heat Transf 2
. {1 3D Plot Group 2 sat franster
. 51 3D Plot Group 3 Electric Currents 3
[ Report Pairs 3
Edges 3
Points 3
# Delete Del
() Disable
<% Rename F2
{2 Properties
[ZL  Dynamic Help ‘ F1

Context Menu

Notice how every step of the modeling process, from defining global variables to the
final report of results, is easy to see. Moreover, when any node in the tree is
right-clicked, a context menu appears to show you appropriate actions.

These actions include everything you need to build and document a model. So rather
than opening separate windows for the various settings (like geometry, physics, mesh,
or results) you just right-click.
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If you choose an action that requires specification, the associated Settings window
appears adjacent to the Model Builder, as shown here.

7 Madel Builder ¥ = O[#¢ Settings @ =g

4 % busbar.mph (root)

Joule Heatin
. E Global Definitions - 9

4 A} Modell {mod1) - Interface Identifier
> = Definitions
4 J’\ Geometry 1 Identifier:  jh

> ,5:’ Work Plane 1 (wpl)
& Bxtrudel (extl)
5 Work Plane 2 (wp2) Selection: | All domains
& Bxtrude 2 (extd)
> ,5:’ Work Plane 3 (wp3)
& Bxtrude 3 (ext3)
@] Form Union (fin)
. @8 Materials
*  amm Joule Heating (jh)
- E53 Mesh1
4 g2 Studyl
[ »Step 1: Stationary 1 ~ Surface-to-Surface Radiation
» [Fr. Solver Configurations
4 g1 Results
. i Data Sets
5% Derived Values
Tables [T] Activate port sweep

- [l 3D Plot Group 1
- {El 3D Plot Group 2 » Dependent Variables
- [El 3D Plot Group 3

[ Report

Domains

g

PN

[T Surface-to-surface radiation

~ Port Sweep Settings

Selected Node and its Settings

You can return to any particular Settings window by simply left-clicking on the
associated node. The result is a streamlined workspace, since there is no longer the
need to open multiple windows.

As you create the model, each step is then recorded in the Model Builder. If, for
instance, your model required a certain sequence of steps to get the right geometry,
these would all be listed in the order you set. (See the geometry section of the figure
above.) Even better, this series of steps can be edited and rerun without having to
repeat the entire simulation. Complicated solver sequences you might need for
different studies also benefit greatly from this feature.

As you work with the COMSOL Desktop with the Model Builder, you will grow to
appreciate the organized and streamlined approach. But any description of a user
interface is inadequate until you try it for yourself. So in the next few sections, you
are invited to work through some examples to familiarize yourself with the next
generation of simulation software.
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Electrical Heating in a Busbar

In order to get acquainted with COMSOL Multiphysics, it is best to work through a
basic example step by step. The directions in this section will cover the essential
components of the model building procedure, highlighting several features and
demonstrating common simulation tasks along the way. At the end, you will have
completed building a truly multiphysics model.

The model that you will create analyzes a busbar designed to conduct a direct
current from a transformer to an electric device (see below). The current conducted
in the busbar, from bolt | to bolts 2a and 2b, produces heat due to the resistive
losses, a phenomenon referred to as Joule heating. The busbar is made of copper
while the bolts are made of titanium. This choice of materials is important since
titanium has a lower electric conductivity than copper and will be subjected to a

higher current density.
Titanium Bolt 2a

Titanium Bolt 2b Titanium Bolt |

The goal of your simulation will be to precisely calculate how much the busbar will
heat up. Once you have captured the basic multiphysics phenomena, you will also
have the chance to investigate thermal expansion yielding structural stresses and
strains in the busbar and the effects of cooling by an air stream.

The Joule heating effect is described by conservation laws for electric current and
energy. Once solved for, the two conservation laws give the temperature and electric
field, respectively. All surfaces, except the bolt contact surfaces, are cooled by natural
convection in the air surrounding the busbar. You can assume that the bolt
cross-section boundaries do not contribute to cooling or heating of the device. The
electric potential at the upper-right vertical bolt surface is 20 mV, and that the
potential at the two horizontal surfaces of the lower bolts is 0 V.
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Start COMSOL by double-clicking its icon on the desktop.

When the Model Wizard opens, select a
space dimension; the default is 3D. Click
the Next button = to continue to the

physics page.

In the Add Physics step, click the Heat
Transfer folder, right-click Joule Heating

and Add Selected.

Click the Next button =.

3 Model Wizard & -

Select Space

Dimension FER= |

@ 3D
(0) 2D axisymmetric
12D
() 1D axisymmetric
1D
@ 0D

3 Model Wizard @ =0

Add Physics EER |

> I Electrochemistry
» 4% Fluid Flow
4 Heat Transfer
g Heat Transfer in Solids (ht)
B Heat Transfer in Fluids (ht)
{57 Heat Transfer in Porous Media (ht
Heat Transfer in Participating Met
% Heat Transfer with Surface-to-Sur,
n Bicheat Transfer (ht)
» — Conjugate Heat Transfer
u Heat Transfer in Thin Shells (htsh)
Surface-to-Surface Radiation (rad]

Radiation in Participating Media (1
- Induction Heating (ih)
- Joule Heating (jh)

Microwave &l add Selected
@ Plasma

The last Model Wizard step is to select the Study Type.

8 | Thorough Example: The Busbar
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Select the Stationary study type and click (15 odel Wisard =g
the Finish button #. Any selection from
the Custom Studies list needs manual

Select Study Type @

Studies

fine-tuning.
g 4 (&% Preset Studies

= Frequency-Stationary

Preset Studies contains studies that have solver )
¥ Frequency-Transient

and equation settings adapted to the Selected | Stationary
physics, in this example, Joule Heating. N @%J;T:S?f:i:dent

If you are planning to draw the geometry in detail,
define the parameters in this section. If you plan
to load the geometry from a file, you can browse
through this section briefly and skip to
“Geometry" on page | 1I.

The Global Definitions in the Model Builder
stores Parameters, Variables, and Functions with
a global scope. You can use these operations in
several Models. In this case, there is only one
Model | node where the parameters are used.

Since you will run a geometric parameter study
later in the example, define the geometry using
parameters from the start. Do this by entering
parameters for the length for the lower part of
the busbar, L, the radius of the titanium bolts,

rad_1, the thickness of the busbar, tbb, and the width of the device, wbb.

Also add the parameters that will control the mesh, mh, a heat transfer coefficient for
cooling by natural convection, htc, and a value for the voltage across the busbar,
Vtot.
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Right-click Global Definitions = and
select Parameters to create a list of

#i Settings @ =0

) P Parameters
parameters Inthe Parameters table, click

~ Parameters

the first row under Name and enter L.

MName |Explssion Value +
L 9[cm] 0.09 m
rad_1 B6[mm] 0.006 m
thb 5[mm] 0.005m | _
wbb 5[cm] 005m |~
mh B6[mm] 0.006 m
htc SIW/mA2/K] 5 Wi (m®

4 | i | b
T+ & %

MNarne:

Vot

Expression:

20[mv]|

Description:

Bushar voltage

Click the first row under Expression and
enter the value of L, 9[cm].

Note that you can enter any unit inside the square brackets.

Continue adding the other parameters: L, rad_1, tbb, wbb, mh, htc, and Vtot
according to the Parameters list.

It is a good idea to type in descriptions for variables, in case you forget or share the
model with others.
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Here you can take a shortcut by loading the model geometry from the Model Library.

Open Model Library from the File
menu. 13 Untitled.mph - COMSOL Multiphysics
Edit Options Help
[0 MNew
=~ Open..

Open Model Library ...

In the Model Library, select i ettings [l Model ibrary 23 =5
COMSOL Multiphysics>Multiphysics ¢ &
>busbar_geom and then click Open. Model Library E
Alternatively, you can construct the busbar
geometry using the parameters entered _
. » ¥ CFD Module .
above with the COMSOL geometry tools. If 4 18 COMSOL Multiphysics
you would like to see this now, have a look b Acoustics T
i [P Chemical Engineering
at "Geometry Sequences” on page 63. » [ Diffusion
i [P Equation-Based Models
Once you have created or imported the » [ Fluid Dynamics =l
. . . . i [ Geophysics 3
geometry, experimenting with different o I Heat Transfer
dimensions is easy: update the values of L, 4 Bz“';iph;"i“
usbar
tbb, or wbb, and rerun the geometry @ busbar_box mn
[ 7 busbar_geom
nce.
Seque ce @ free_convection
[ 7 marangeni_convection
[ 7 thermal_actuator_jh
. [P Structural Mechanics S
| 1 ] ¢ A
’ Open ] ’ Documentation ]
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Under Global Definitions click
Parameters. In the Settings window, select

the wbb parameter’s Expression column
and enter 10[cm] to change the value of

the width wbb.

In the Model Builder, click the Form Union

node # and then the Build All button

#i Settings =0

Pi Parameters

~ Parameters
MName | Exg | Value +
L 9[cm] 0.09 m
rad_1 B6[mm] 0.006 m
thb 5[mm] 0.005m | _
whb 01m |
mh B6[mm] 0.006 m
htc SIW/m 2K 5 Wi (m®
Viot 20[mV] 002v
] T ¢
it & Xz

MName:

whb

Expression:

10[cm]|

Description:
Busbar width

i to rerun the geometry sequence.

a3
a

T Model Builder

busbar_geom.mph (root)
= Global Definitions
Pi Parameters
Model 1 (mod1)
= Definitions
4 A Geometryl
& A5 Work Planel (wpl)
% > Extrude 1 (ext)
[ % Work Plane 2 (wp2)
iy Bxtrude 2 (extd)
& A5 Work Plane 3 (wp3)
iy Bxtrude 3 (ext3)
#4, > Form Union (fin)

\

-

#i Settings

# Finalize
+ Finalize

Finalization method:

Form a union

Relative repair tolerance:

le-6

In the Graphics toolbar click the Zoom Extents button . You should get a

wider busbar.

(d'; Graphics

e &~ aa:

I 2 | Thorough Example: The Busbar
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wbb=5cm wbb=10cm

e Left-click and drag in the Graphics window to rotate the busbar. Right-click
and drag to move it. Center-click and drag to zoom in and out. To get back
to the original position, click the Go to Default 3D View button . on the
Graphics toolbar, e

(¢ Graphics fHes~aQ@é@| - kikzklgo[faaiR(C. @ m=0)
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Return to the Parameters table and i Settings @=o
change the value of wbb back to s Parameters
5[cm].
~ Parameters

In the Model Builder, click the Form — 49 [ Value
Union node # and then the Build All L 9[cm] 0.09 m

- rad_1 B6[mm] 0.006 m
button [ to rerun the geometry o Stmm] 0005 m|
sequence. whb B oosm |

. ) mh B6[mm] 0.006 m

On the Graphics toolbar, click the htc SW/mA2/K 5 W/(m?
Zoom Extents button F. Veot 20[mV] WY

Now save your work up to this point
as busbar.mph.
whb

Expression:

5[cm]]

Description:

Busbar width

Experienced users of other CAD programs are already familiar with this approach
since all major CAD platforms include parameterized geometries. To support this
class of users and to avoid redundancy, COMSOL offers the LiveLink™ family of
products. These products connect COMSOL Multiphysics directly with a separate
CAD program, so that all parameters specified in CAD can be interactively linked
with your simulation geometry. The current product line includes LiveLink™
interfaces for SolidWorks®, Inventor®, and Pro/ENGINEER®.

It is also worth noting that the LiveLink™ interface for Matlab® is available for those
who want to incorporate a COMSOL Multiphysics model into an extended
programming environment.

Having completed the geometry for your model, it is time to define the materials.

MATERIALS

The Materials node administrates the material properties for all physics and all
domains in a Model node. The busbar is made of copper; and the bolts are made of
titanium. Both these materials are available from the Built-In material database.

| 4 | Thorough Example: The Busbar



0 In the Model Builder, right-click & Materials

Materials and select Open Material 4 &%JD‘ “d8 Material
" - @ Open Material Browser

In the Material Browser, expand the i Settings| : =
@ ! #2¢ Settings | % Material Browser 52 8

Browser.

Built-In materials folder, right-click Ox|+
Copper and select Add Material to Material Browser
Model. Materials
Search
#8 Brick -
#8 Castiron

#8 Concrete @
& Copper =

@5 FR4| 4= Add Material to Madel

# Glas
& Grar Remove Selected
igh-strength alloy stee

#E High gth alloy |

# Iron

# Magnesium AZ31B

# Mica -
4 T | 3

(éé:l Settings . % Material Browser] = Eﬂ

6 Click the Material Browser window
tab, and scroll down to Titanium
beta-21S in the Built-In material folder 6
and add this material to the model.

6 In the Model Builder, collapse the 4 V8 busbar.mph (root)
4 = Global Definitions
Geometry | node to get a better b Parameters
overview of the model. 4 1) Model1 (modl)
> = Definitions
6 b A Geometryl
a4 #B Materials
- #8 Copper
[ @8 Titanium beta-215
I o Joule Heating (jh)
1 8 Mesh1
I 2 Studyl
i+ i) Results

6 Under the Materials node, click 4 U Model1 (modl)

C > = Definitions
opper. b A Geometryl

a4 #B Materials
» | &8 Copper 6
[ @8 Titanium beta-215
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G In the Settings window, locate the + Material Contents
Material Contents section.

Property | MName | Value
. . . /' Densi h 8700
The Material Contents section provides ESi. =
~ Heat capacity at constant pressure  Cp 385
useful feedback on the model’'s material /' Relative permittivity epsilonr 1
property usage. Properties that are both il Ectiidconductviny SKmalll 599%8e7
. . . ~" Thermal conductivity k 400
Iﬁequ'red by the ph)’SICS and available from Coefficient of thermal expansion alpha  17e-6
the material are marked with a green
check mark .. Properties required by the G

physics but missing in the material will
resultin an error and are therefore marked
with a stop sign @. A property that is not
used in the model is unmarked.

You may note that the Coefficient of thermal expansion at the bottom of the list is
not used, but you will need it later for expanding your model with heat induced
stresses and strains. Since you added the Copper material first, all parts will by
defaults have copper material assigned. In the next step you will assign Titanium
properties to the bolts, which will override the Copper material assignment for those

parts.
G In the Model Builder, click the Titanium 4 & Model1 fmod2)
- = Definitions
beta-21S node. A Geometry1
a4 #B Materials
. &8 Copper

. @8 Titanium beta-215 G
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(8

Select All Domains in the Selection list
and then click Domain 1. Click the
Remove from Selection button —.

Cross-check: Domains 2, 3,4, 5, 6, and 7.

M& Material Browser| [ = O]

& Material

Selection: IhManal |

All demains

Geometric Scope
Geometric entity level:

M& Material Browser| [ = O]

& Material

Geometric Scope
Geometric entity level:

O g
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Be sure to investigate the Material 5 Settings .8 Material Browser| =g

@ Contents section in the Settings
window. All the properties used by

& Material

Geometric Scope

Geometric entity level:

the physics interfaces should have a
green check mark ..

2 %, o
3
4 o -
5 & ¥
6
7
» Material Properties
g ~ Material Contents
| Property MName
~"  Electric conductivity sigma
~ Heat capacity a...stant pressure  Cp
~ Relative permittivity epsilo
~" Density rtho
~ Thermal conductivity k
Relative permeability mur

Coefficient of ..rmal expansion alpha
Young's modulus E

Poisson's ratio nu

@ Close the Material Browser. m i3 Settings | %% Material Browser 52 =0

O pelm
Close |

The domain settings for the Joule Heating physics interface are complete now that
you have set the material properties for the different domains. Next you will set the
proper boundary conditions for the heat transfer problem and the conduction of
electric current.
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In the Model Builder, expand the Joule Heating 4 Joule Heating (jh)

node to examine the default physics interface

nodes.

Joule Heating Model | contains the settings for heat

A

AT AT AV JAT

conduction and current conduction. The heating effect

Joule Heating Model 1
Electromagnetic Heat Sourcel
Thermal Insulation 1

Electric Insulation 1

Initial Values 1

for Joule heating is set in Electromagnetic Heat Source |. Thermal Insulation |

contains the default boundary condition for the heat transfer problem and Electric
Insulation | corresponds to the conservation of electric current. Initial Values |
contains initial guesses for the nonlinear solver for stationary problems and initial

conditions for time-dependent problems.

Right-click the Joule Heating node. In the second section of the context

menu—the boundary section—select Heat Transfer >Heat Flux.

*  amm Joule Heating (jh)

> &8 Mesn1 N Joule Heating Model
& g
> Study 1
'] Resu:;;:s Electromagnetic Heat Source

Infinite Elements

AT FAT JAT AT

Initial Values
Heat Transfer

Electric Currents

Periodic Condition
Heat Transfer
Electric Currents
Pairs

Edges

Points

Boundary Section

In the Settings window, select Al
boundaries in the Selection list.

Assume that the circular bolt boundaries are
neither heated nor cooled by the surroundings.
Therefore we will in the next step remove them
from the heat flux selection list, which leaves
them with the default insulating boundary
condition for Heat Transfer interfaces.

AT AT AV AV

Domain Section

#i Settings
Heat Flux

Boundaries

Temperature
Thermal Insulation
Outflow

Symmetry
Convective Cooling

Heat Flux

Selection: [Manual

Manual

All boundaries
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Rotate the busbarto inspect
" the back. Click one of the
circular titanium bolt
surfaces to highlight it in
green. Right-click anywhere
in the Graphics window to
remove this boundary from
the Selection list. Repeat
this for the other two bolts.

Cross-check: Boundaries 8,
|5, and 43 are removed from the Selection list.

In the Settings window, click the ~ Heat Flux

" Inward heat flux radio button. Enter ©) General inward heat flux
htc in the Heat transfer coefficient @ Inward heat flux
field, h. Qu=h(TeeT)

Heat transfer coefficient:

Continue by setting the boundary
conditions for the electric current.

‘ h  ht wi(m2K
< c /im=K)
External temperature:

Text 293.15[K] K

In the Model Builder, right-click the
" Joule Heating node. In the second section of the context menu—the
boundary section—select Electric Currents>Electric Potential.

4 | o Joule Heatj=~ = §
5% JouleH ~©  JouleHeating Model
57 Electroi *5 | Electromagnetic Heat Source
E Thermz *5°  Infinite Elements
: El.et.:tric 5 Initial Values
@ Initial W
Heat FI Heat Transfer ¥
- B8 Mesh1 Electric Currents »
% ;:Jsill';:: * Periodic Condition
Heat Transfer 3 A\
Electric Currents i * Boundary Current Source
Pairs »| *5 Ground
Ednes N 5 Electric Potential
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e Click the circular face of the upper
titanium bolt to highlight it and
right-click anywhere to add it to the
Selection list.

Cross-check: Boundary 43.

c In the Settings window, enter Vtot in '~ Blectric Potential [
“ the Voltage field. Voltage:

The last step in the physics settings is G Vo | Vtat
to set the two remaining bolt surfaces
to ground.

G In the Model Builder, right-click the Joule Heating node. In the boundary
section of the context menu, select Electric Currents>Ground.

4| JouleHe .
5 Jould *57 Joule Heating Model
a Elect +a Electromagnetic Heat Source
a Ther "a Infinite Elements
% ]E'f’ff *57 Initial Values
nitia Heat Transfer »
[} Heat
5 Elect Electric Currents 3
éz & Meshl | 41 periodic Condition G
Study 1
Results Heat Transfer 3
| Electric Currents 3 "@ Boundary Current Source
Pairs » | +a Ground |
Edges , | 71 Electric Potential

@ In the Graphics window, click
one of the remaining bolts to
highlight it. Right-click
anywhere to add it to the
Selection list.

Repeat this procedure for the
last bolt.
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Cross-check: Boundaries 8 and 15.

Click the Go to Default 3D View button . on the Graphics toolbar.

o i o

I Mg =~ @af [l 12 = | @ o o@= R|[C)0 & @
-

MESH

The simplest way to mesh is to create an unstructured tetrahedral mesh. This will do
nicely for the busbar. You can also create several mesh sequences, see “Mesh
Sequences” on page 36.

0 In the Model Builder, right-click the Mesh | node and 4 5 Mesh1 0
select Free Tetrahedral. Click the Size node 2. a
@ = Free Tetrahedral 1
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e In the Settings window, select the Custom
button under Element Size. Enter mh in the
Maximum element size field. Enter mh-mh/

faa
it

3 in the Minimum size edit field, and enter | & 5128

0.2 in the Resolution of curvature field. Element Size

Note that mh is 6 mm—the value entered © Predefined
@ Custom

earlier as a global parameter.
~ EHement Size Parameters

Maximum element size:

mh & m
Minimum element size:

rmh-mhy/3 & m

Maximumn element growth rate:
15

Resolution of curvature:
02 2%

Resolution of narrow regions:

05

7 to create the mesh.

e Click the Build All button

AN
Ry
R
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STUDY

G To run a simulation, in the G
Model Builder, right-click Study T
| and select Compute =. [~ Sted = Compute
4 g1 Results sz p o
The Study node automatically defines §i Datg Fn TEMUHIOSWE
. . . 825 [arj Study Steps 3
a solution sequence for the simulation 3 Tob
based on the selected physics and the FRep| o Fomme P
study type. & Properties
[ZL  Dynamic Help F1

The simulation only takes a few

seconds to solve.

RESULTS

The default plot displays the
temperature in the busbar. The

A 3306

temperature difference in the device
is less than 10 K, due to the high
thermal conductivity of copper and
titanium. The temperature variations
are largest on the top bolt, which
conducts double the amount of
current compared to the two lower
ones. The temperature is
substantially higher than the ambient
temperature 293 K. G

G Left-click and drag in the
Graphics window to rotate the busbar and visualize the back side.

G Click the Go to Default 3D View button . on the Graphics toolbar to go
back to the default view.

EEEREEEET

¢\ Graphics oo =~ & & é@
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You can change the Range of the color table to visualize the temperature difference
in the copper part.

e Click 3D Plot Group |>Surface I. In the e
Settings window, under Range, select the

“it Setti S| @ = O

Manual color range check box. Enter 323 | o :

in the Maximum field. @ Surface Sl
v Data

Click the Plot button .4.

 Expression = B~

Expression:

T

Unit:

« -
[T] Description:

A 330.6

323

m

Temperature

+ Range
Manual color range

Minimum: 3226263

Maximum: 323 e

—

3226

v 3226

With this solution in hand, you can create an image that will be displayed by
COMSOL when browsing for model files.

Go to the File menu and select Save Model Image.

There are two other ways to create images from this plot. One way is to use the
Image Snapshot button @ in the Graphics toolbar for directly creating an image, and
another is to add an Image node i# to the Report by right-clicking the Plot Group
of interest. The second option lets you reuse the Image Settings if you update the
model.

The temperature distribution is symmetric with a vertical mirror plane running
between the two lower titanium bolts and running across the middle of the upper
bolt. In this case, the model does not require much computing power and you can
model the whole geometry. For more complex models, you should consider using
symmetries in order to reduce the size of the model.
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Another plot of interest shows the current density in the device.

G In the Model Builder, right-click 4 151 Results G
i Data Set:
Results and select 3D Plot Group. P EE o
225 Derived Values
HH Tables
a 3D Plot Group 1
] Surfacel
3 3D Plot Group 2 6
3D Plot Group 3
[ Report = Plot F8
Plot in Window
*iE Volume
*= Arrow Volume
*i2] Surface

6 Right-click 3D Plot Group 3 and
select Surface.

@ In the Settings window, in the Expression section, click the Replace Expression
button = -. Select Electric Currents>Current density norm (jh.norm)). This is
the variable for the magnitude, or absolute value, of the current density

0@

-

vector.

#i Settings v

= Surface

- Data

 Expression = B~ @

Joule Heating 3 |

Expression:
T Joule Heating (Electric currents) 4 Current density 3
Unit: Joule Heating (Heat transfer) 3 Current density norm (jh.norml)

6 Click the Plot button .4.
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The resulting plot is almost uniform due to the high current density at the contact
edges with the bolts. Left-click and drag the busbar in the Graphics window to view
the back side.

A 5.855x10°
x10°

¥ 2483

Click the Go to Default 3D View button . on the Graphics toolbar. Change the
Range of the color table in the Settings window to visualize the current density
distribution.

G Under Range, select the Manual = o
color range check box. Enter 1e6 in [¥] Manual color range
the Maximum field. Click the Plot Minimum: 3150509
button .#. Save the model as 0
busbar.mph.

6 Maximum: 1e6
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This plot shows how the current takes the 4 5855x10°
shortest path in the 90-degree bend in the e
busbar. Moreover, the edges of the busbar
outside of the bolts are hardly utilized for

current conduction.

¥ 2483

e Rotate the device to show . sajls::uﬁ
the back of the busbar
where you will see the
high current density
around the contact
surfaces of the bolts.

¥ 2483

(9]

Continue the exercise by adding your own plots and investigating ways of generating

cross section plots and cross section line plots.

Now you have completed a basic multiphysics simulation. The following sections are
designed to increase your understanding of the steps you implemented up to this
point as well as to extend your simulation to include other relevant effects, like
thermal expansion and fluid flow.
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This section will help you explore working with Parameters, Functions, Variables, and
Model Couplings. For this purpose you can continue working with the same model
from the preceding section. Locate and open the file busbar.mph if you do not
already have it on the COMSOL Desktop.

Global Definitions and the Definitions contain functionality that assists you in
preparing model inputs and model couplings and in organizing simulations. You have
already used the functionality for adding Parameters to organize model inputs in
Global Definitions.

Functions, available as both Global Definitions and Definitions, contain a set of
predefined functions that can be useful when you set up multiphysics simulations. For
example, the Step function can create a smooth step function for defining different
types of switches. To illustrate using functions, assume that you want to add a
time-dependent study to the busbar model by applying an electric potential across
the busbar that goes from 0 V to 20 mV in 0.5 seconds. For this purpose, you could
use a step function to be multiplied with the parameter Vtot. Add a function that
goes smoothly from O to | in 0.5 seconds to find out how functions can be defined
and verified.
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Right-click the Global Definitions node and select Functions>Step.

7 Model Builder ¥ =0
4 '3 busbar.mph (root)
a = Glob— X
P |3 Variables
I
4 ¥ Busl Functions v FEL Analytic
= A i
[ = D i ' Interpolation
b A . Piecewise
a4 #B Materials
- %8 Copper “flx) External
i+ &8 Titanium beta-215 * /i Gaussian Pulse
4 o Joule Heating (jh) “f) MATLAB
57 Joule Heating Model 1 /R
57 Electromagnetic Heat Source 1 ) amp
5 Thermal Insulation 1 Tt Random
50 Electric Insulation 1 “ ]l Rectangle
§ EitiaIF‘T’alulesl e
eat Flux : :
AT |
5 Electric Potential 1 ) e
5 Ground1 "Wy Waveform
In the Settings window, enter 0.25
in the Location edit field to set the - -
) ) “i* Settings g | g
location of the middle of the step,
. I Ste
where it has the value of 0.5. s
~ Function Name
Function name:  stepl
~ Parameters
Location: 0.25
From: 0
To: 1
~ Smoothing
Size of transition zone: 0.5

Expand the Smoothing section. In the Size of the Transition zone, set the
width of the smoothing interval. Enter 0.5 in this edit field.

Click the Plot button ».#.
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The plot verifies that you have defined the function correctly.

step1it)

You can also add comments and rename the function to make it more descriptive.

Right-click the Step | node in (- yodel Builder v =0

the Model Builder and select 4 ¥ busbar.mph (root)
a4 = Global Definitions

Proper‘tles. Pi Parameters
I Stepl (sp-=2
4 A\ Busbar (mog ¥ Delete Del
. = Definitio (7 Disable
‘F\ Geomett <% Rename F2
a4 #B Materials
. &8 Copy {53 Properties
. #8 Titan ] .
. loule Hel & Dynamic Help F1
In the Properties window you g Propertics Zl@=no
can enter the desired @ Step
information.
+ Node Properties
MName: Stepl
Tag: stepl
Author: comsol

Date created: | May 25, 2010 1:16:32 AM

Version: 4.0a
Comments: |Created for COMSOL -
tutorial.
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Global Definitions and Definitions can contain Variables, which are expressions of the
dependent variables—the variables that are solved for in a simulation. You can define
global variables that can be used in several models.

For the sake of describing this procedure, assume that you want to introduce a
second model to represent an electric device connected to the busbar through the
titanium bolts.

A first step would be to specify that Model | represents the busbar by renaming it.

Right-click the Model | node and select Rename.

7 Model Builder ¥ =0
4 '3 System.mph (root)
4 = Global Definitions
Pi Parameters

4 W) Modell (modl
. = Definitions | &%  Add Physics
4 ’E\ Geometryl| £ Mesh
. @8 Materials
* umm JOUlE Heatin # Delete
o B3 Mesh1 < Rename
4 [ Electric Device
. = Definitions | & Properties
> g :-1:;::::2 [ZL  Dynamic Help F1

> @ Heat Transfer (ht)
> % Electrostatics (es)
55 Mesh 2 Rename Madel

> e Studyl
- i Results MNew name: BusbarI

In the Rename Model dialog box, type Busbar.
When you have renamed the Model | node to Busbar, save the model.
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The next steps are only demonstrated here and 4 E Global Definitions
Pi Parameters
a= Variables 1
Definitions under Busbar (modl), you could 4 ) Busbar (mod)

4 = Definitions

you do not need to reproduce them. In the

introduce a Model Coupling that integrates any Jou Integration 1 (intop)

Busbar (modl) variable at the bolt boundaries é Boundary System 1 (sys1)
. . . _ - [ view1
facing the electric device. You could then use this A Geometry1
coupling to define a Variable—in Global - 8 Materials
L . - am JOUle Heating (jh)
Definitions—that calculates the total current. This . 5 Mesh1
variable would then be globally accessible and 4 |1 Blectric Device (mod2)
o - = Definitions
could, for example, form a boundary condition for . ¥, Geometry 2
. . o Material
the current that is fed to the electric device in the & Materisls
» § Heat Transfer (ht)
Electric Device (mod2) node. - % Electrostatics (es)

The Model Couplings in Definitions have a wide range of use. The Average,
Maximum, and Minimum Model Couplings have applications in generating results as
well as in boundary conditions, sources, sinks, properties, or any other contribution
to the model equations. The Probes are meant for monitoring the solution progress.
For instance, you can follow the solution in a critical point during a time-dependent
simulation or at parameter value in a parametric study.

You can also use the Model Couplings to map variables from one face in a model to
another (called extrusion couplings) and also to integrate a variable along curves and
map from one entity to another (called projection couplings).

To learn more about working with Definitions, in the Model Builder select a
Definitions or Global Definitions node and press FI or go to the Help menu and
select Dynamic Help. The Dynamic Help displays help on the selected item in the
Desktop and provides links to the documentation. Please allow up to a minute for
the Dynamic Help to load the very first time it is activated. (The next time it will be
quicker).

You will find an example of using the average operator in “Parameter Sweeps, Parallel
Computing” on page 57.

In “Built-in Functions” on page 90, you will find a list of available COMSOL functions.
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You have used the functionality in Materials to access the properties of copper and
titanium in the model of the busbar. This section will help you defining material
properties and creating your own material library. Locate and open the file
busbar.mph if you do not already have it on the COMSOL Desktop.

In Materials, you are also able to create your own materials and save them in your
own material library. You can also add material properties to existing materials. In
cases where you define properties that are functions of other variables, typically
temperature, the plot functionality helps you in verifying the property functions in the
range of interest.

First investigate how to add a property to an existing material. Assume that you want
to add the bulk modulus to the copper properties, using a bulk modulus of 140 GPa.

CUSTOMIZING MATERIALS

In the Model Builder, under Materials, 4 W1 Model1 (modi)
G || k C r . = Definitions
chic opper. > :F\ Geometry 1
a4 #B Materials
- %8 Copper G
. @8 Titanium beta-215
G In the Settings window, locate the T e T T
Materials Properties section, which 4 Basic Properties E
contains a list of all the definable Characteristic Acoustic Impedance
. . X Bulk Modulus L
properties. Expand the Basic properties G cDmp“% & Add to Material i
node, right-click Bulk Modulus, and select Compresstomey—— i
) Piezoelectric Coupling d
Add to Material. Piezoelectric Coupling e
Density
This will let you define the Bulk modulus Elevation
. Elasticity
for the copper in your model. Electric Conductivity
Electron Mobility -
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©

Locate the Material Contents section. A ' material Contents
Bulk modulus row is now available in

| Property | MName | Value *
the table. The stop sign @ indicatesthe | © Bukmodulis K e
value is not yet defined. Define it by g Density LN 8700
~" Heat capa...pressure Cp 385
clicking the Value column for the Bulk | rezrepa oy | st b L
modulus row and entering 140e9. ~ Electric conductivity sigma 593987
+~ Thermal c..uctivity k 400
Thermal e..efficient alpha 17e-6
Relative ..meability mur 1 _
Young's modulus  E 1109
Poisson's ratio nu 0.35 il
4|n,rrr | o 4“:

By adding a material property, you have changed the Copper material. However, you
cannot save this material in the Built-In library, since this is read-only. Instead, save it

in your own library.

o

©

In the Model Builder, right-click & Materias G
Copper and select Add | Copper
Material to “User Defined - #B Titaniun * 8 User-Defined Property Group

- Joule Heati

Library”. 57 JouleH

i Add Material to Library "User Defined Library”

Right-click Materials and select

Open Material Browser. In the Material Browser, right-click User Defined
Library and select Rename Selected. Enter My Materials in the Enter New
Name dialog box.

» [l Recent Materials
> [ Material Library -0.0
> % Built-In
» ¥ AC/DC -0.0
» 4% Liquids and Gases
> b MEMS
> %, Piezoelectric
. = : 01
4 ]]l User Defined Library
# Copper
Enter New Name ﬁ
MName: My Materials

Orientation/variation:
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A model can contain different mesh sequences for generating meshes with different
settings. These sequences can then be accessed by the study steps. In the Study, you
can select which mesh you would like to use in a particular simulation.

In the busbar model, you will add a second mesh node to create a mesh that is
refined in the areas around the bolts and the bend. You do this by increasing the
mesh resolution on curved surfaces. Locate and open the file busbar.mph if you do
not already have it on the COMSOL Desktop.

c To add a second mesh node, right-click the

Busbar node and select Mesh. 4 1) Bushar (mod)
. = Definitions | 5% Add Physics
This creates a new Meshes parent node that > A\ Geometryl| *E5  Mesh

contains Mesh | and Mesh 2.

Right-click Mesh 2 and select Free Tetrahedral. 4 £5 Meshes
6 » 58 Mesh1 6
» 658 Mesh 2
» s Studyl :
4 g1 Results
. Data Set

Build All

* 4% Free Tetrahedral

c Click Size in Mesh 2. 4 (5 Meshes

- B2 Meshl

a4 55 Mesh 2
s ©

A% > Free Tetrahedral 1

36 | Mesh Sequences



o

Now compare Mesh | and Mesh 2 by clicking
the respective node. The mesh is updated in

In the Settings window, locate the

Element Size section.

Click the Custom button. Enter mh/

® 66 o0

o

#i Settings il

|@ =0

2 Size
Element Size

() Predefined | Mormal

@ Custom

~ EHement Size Parameters
Maximum element size:
mh/2
Minimum element size:

mh/2-mh/6

Maximumn element growth rate:

15
Resolution of curvature:
0.2
Resolution of narrow regions:

0.5

2 in the Maximum element size field and mh/2-mh/6 in the Minimum element
size edit field. Enter 0.2 in the Resolution of curvature edit field.

Click Build All

the Graphics window.

Another alternative is to run a parametric
sweep using the parameter for the maximum
mesh size, mh, that you defined previously in

Global Definitions.

In order to keep this model in a separate file
for later use, save the model with a new

name, busbar_I.mph.
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COMSOL's distinguishing characteristics of adaptability and compatibility are
prominently displayed when you add physics to an existing model. In this section, you
will realize the ease with which this seemingly difficult task is performed. By following
these directions, you can add structural mechanics and fluid flow to the busbar
model.

After completing the Joule heating simulation, you now know that there is
temperature rise in the busbar. So it is logical to ask: What kind of mechanical stress
is induced by thermal expansion? To answer this question, COMSOL Multiphysics
makes it easy for you to expand your model to include the physics associated with
structural mechanics. The following set of instructions, which requires the Structural
Mechanics Module, shows you how to do this. If you are more interested in adding
cooling by fluid flow, you can skip to the next section, “Fluid Flow” .

Open the model busbar.mph that you created earlier.

In the Model Builder, right-click the Busbar al
node and select Add Physics .

Bushar (mod1)
=| & Add Physics
> ‘F\ B Mesh
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In the Model Wizard, select
Structural Mechanics>Solid

'3 Model Wizard @ =0
Mechanics. There are thr
ec al cs ere aret Iee ways to Add Physics o
add this node: double-click,
. £}l Acoustics -

right-click and Add Selected, or click . %5: Chemical Species Transport
the Add Selected button . > 1L Electrochemistry

» 4% Fluid Flow
Heat Transfer B
» @ Plasma
» g5 Radie Frequency
4 == Structural Mechanics
[5} Solid Mechanics (solid)
@ Thermal| &= Add Selected
7 Poroelastiemytporoy
[7] shell (shel)
-_|’r Beam (beam)
£ Truss (truss)

= Joule Heating and Thermal Expan
), Piezoelectric Devices (pzd)
i Mathematics
4 [ | +

¥ X

Click the Finish button .
Save the model with a new name, busbar_II.mph. You will use it shortly.

G When adding more physics interfaces, you need to make sure that any
materials included in Materials have all the required properties for the
selected physics interfaces. In this example, you know that all properties are
available for copper and titanium.

You can start by adding the effect of thermal expansion to the structural analysis.
Note that there is also a predefined multiphysics interface for thermal stresses and
strains in the Structural Mechanics Module.

In the Model Builder, under Solid 4 4 Joule Heating (jh)

Joule Heating Model 1
Electromagnetic Heat Sourcel

Mechanics, right-click the Linear
Elastic Material Model | node and
select Thermal Expansion.

Thermal Insulation 1
Electric Insulation 1
Initial Values 1
Heat Flux1
Electric Potential 1
Ground 1

olid Mechanics (solid)
Linear Elastic Material Model 1

Thermal Expansion 1

Freel
Initial Values 1

J
5
5
5
5
5

a =

4

WE o AT AT

AT AT
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On the Thermal Expansion page, under

" Thermal Expansion, select Temperature

(jh/jh1) from the Temperature list.

This is the temperature field from the

Joule Heating physics interface (jh/jhm1)
and couples the Joule heating effect to the

thermal expansion of the busbar.

Next, fix the busbar at the position of the

titanium bolts.

In the Model Builder,

“ right-click Solid Mechanics
and select Fixed
Constraint.
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4[5 Solid Mechanics (solid)
=
PR

#i Settings =0

=

% Thermal Expansion

Domains

Selection: ’AII domains v]

P R STTIAT

+ Model Inputs

Temperature:

T | User defined -

W | User defined |

« Thermal Expansion

Coefficient of thermal expansion:

o From material - ]

Strain reference temperature:

Trer 29315[K] K

Linear Elastic Materi| 5 Linear Elastic Material Model
1= Lo
@ Thermal Expansi +5  Hyperelastic Material Model
5 Freel I - - .
5 Initial Values 1 @ Viscoelastic Material Model
& £ Mesh1 “5 Elastoplastic Material Model
[ s Studyl 5 Geomechanics Material Model
a Results “I Bodyload
" “5 Perfectly Matched Layers
£3; Derived Values 5 Initial Values
HH Tables
4 3D Plot Group 1 Mare
] Surfacel +5% | Free
[ 3D Plet Group 2 —
- 3D Plot Group 3 *a Fixed Constraint




In the Graphics window,
rotate the busbar to access
the back. Click one of the
bolts to highlight it and
right-click to add the bolt to
the Selection list. Repeat this
procedure for the remaining
bolts.

Cross-check: Boundaries 8,
|5, and 43.

You can now update the Study to take the added effects into account.

RUNNING A STUDY SEQUENCE—JOULE HEATING AND
THERMAL EXPANSION

The Joule heating effect is independent of the stresses and strains in the busbar,
assuming small deformations and ignoring the effects of electric contact pressure.
This means that you can run the simulation using the temperature as input to the
structural analysis. In other words, the extended multiphysics problem is weakly
coupled. As such, you can solve it in two separate study steps—one for the strongly
coupled Joule heating problem and a second one for the structural analysis.

G In the Model Builder, right-click the Study | node and select Stationary to add
a second stationary study step.

4 &5 Study?

I~ st = Compute
> [ire S| + 122 Parametric Sweep G
a (g Result: e -
& Da Study Steps b | ¥ Stationary
2% De % Rename 02 L Time Dependent
Ta *111 Eigenfrequency

When adding study steps you need to manually connect the correct physics
with the correct study step.

Start by removing the structural analysis from the first step.
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Under Study |, click the Stationary | 4 & Studyl
G node. |7 Step 1: Stationary 1 G

|7 Step 2: Stationary
i+ [fre Solver Configurations

* Physics Selection

9 In the Settings window, under Physics
Selection, select the Solid mechanics

Physics interfaces:

(solid) interface in the Physics interfaces Jouleheatini i'hJ
9 Solid mechanics (solid)

list.

G [] Use in this study

G Clear the Use in this study check box.

Then remove Joule heating from the
second step.

Under Study 1, click the Stationary 2 4 & Studyl
e |7 Step1: Stationary 1
|7 Step 2: Stationary
i+ [fre Solver Configurations

node.

* Physics Selection

G In the Settings window, under Physics
Selection, select Joule heating (jh) from
the Physics interfaces list. 6

Solid mechanics (zolid)

Physics interfaces:

G [] Use in this study

Clear the Use in this study check box.
Save the model.

©

Right-click Solver Configurations and

)

4 &3 Studyl
select Delete Solvers. 7 Step 1: Stationary 1
. . |7 Step 2: Stationary 6
Right-click the Study | node and select b [ Solver G

onfigurations
Compute = to automatically create a 4 & Results Y Clear Solutions
b Hi DataSet %, Delete Solvers
solver sequence that solves the BEE Perived )

problems in sequence.
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RESULTING DEFORMATION

“ Click Results > Plot Group 3>Surface .
In the Settings window, click the Replace
Expression button %- and select Solid
Mechanics>Total Displacements from
the context menu. You can also type
solid.disp in the Expression field.

The local displacement, due to thermal
expansion, is displayed by COMSOL as a
surface plot. Next add exaggerated
deformation information.

e In the Model Builder, Results > Plot

#i Settings

o4 | @& T8

= Surface
~ Data

Data set:

 Expression

Expression:

solid.disp
Unit:

m

Group 3, right-click the Surface | node and select Deformation. Save the

model.

4-E /1 vntls BERAEESE

¥ = O)# settings

& Graphics

QAB[L -k = [@C[m=8

& Deformation Surface: Total

~ Expression P

Model1
1

~ Scale

Scale factor: [[] | 1679621
1

17 Step 1: Stationary 1
17 Step 2 Stationary
ati

Surface

v
4516x107°
X107

vo

g e 515 Vot mamors 354

You can also plot the von Mises and principal stresses to assess the structural
integrity of the busbar and the bolts and to check for the susceptibility to fatigue.
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After analyzing the heat generated in the busbar and possibly the induced thermal
stresses, you might want to investigate ways of cooling it by letting air flow over its
surfaces.

Adding the fluid flow to the Joule heating model forms a new multiphysics coupling.
To simulate the flow domain, you need to create an air box around the busbar. You
can do this manually by altering the geometry from your first model. Alternatively,
you can load a file including the geometry and the solution to the Joule heating
problem. In the Model Library, select COMSOL
Multiphysics>Multiphysics>busbar_box and then click Open.

Having loaded or created the geometry, now simulate the air flow according to the
figure below.

Air Outlet

Air Inlet

Start by adding a new parameter for the inlet flow velocity.

In the Model Builder, click Parameters in Global 4 V8 bushar_bax.mph (root)
e a4 = Global Definitions
DeﬁnItIOﬂS. Fi Parameters
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In the Settings window, click the last o ———

row in the Parameters table. Type Vin — e e o
in the Name column and 1e-1[m/s] rad 1 6e-3[m] 0.006 m
in the Expression column. Enter a tbb Se-3lm] 0.005m
whbb Se-2[m] 0.05m
deSCriptiOn of your choice. mh 6e-3[m] 0006 m |E
. , htc SIW/mA2/K] 5 W/(m?®
The next step is to add the material Viot 10mV] T
properties of air in Materials. R 1c-imvs] 01 m/s
4 L 3 ;
i+ &+ X =
MName:
Yin
Expression:
le-1[m/s]
Description:
Inlet velocity

ADDING AIR

“ In the Model Builder, right-click
Materials and select Open Material “

a4 BB Materials
Browser. » & Coppe 8 Material
i &8 Titani #  Open Material Browser
I o Joule Hea

5 Mesh1 Dynamic Help F1
@ In the Material Browser, expand the
Built-In tree. Right-click Air and select Add 9
Material to Model. #3% Settings | %% Material Browser 52 =0
0%+

Material Browser

Materials
Search
4 ¥ Built-In -
# Air e |

4k Add Material to Model

Remove Selected
Aluminum 6063-Tas
# Aluminum
#8 American red oak
#8 Beryllium copper UNS C17200
#8 Brick

#8 Castiron =
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6 Close the Material Browser.

6 In the Model Builder, click Air in the 4 8 Materials

. - %8 Copper
Materials node. » 8 Titanium beta-215
B Air 6
6 In the Graphics window, click the air & = =5

box to highlight it and right-click to add & Material
it to the selection list.

Geometric Scope

Cross-check: Domain . Geometric entity level

Now you can add the physics of fluid flow. Selection:

s

In the Model Builder, right-click the Model | node and select Add Physics .

¢ In the Model Wizard, select Fluid L =g
> -
Flow Smglle Phase Add Physics oo
Flow>Laminar Flow. _
& *%, Recently Used -
» X AC/DC 7]

& cli Acoustics
&+ 4 Chemical Species Transport
& 1L Electrochemistry
a 4% Fluid Flow
4 4% Single-Phase Flow
E— Laminar Flow (spf)
‘»\v o (% Turbulent Flow
— Creeping Flow (spf)
i+ |5 Thin-Film Flow
|+ £ Multiphase Flow
i @ Porous Media and Subsurface Floi_|
i+ —, Non-Isothermal Flow
2§ Fluid-Structure Interaction (fsi)
1) Heat Transfer

~ €@ Plasma
L 1 ] »

Q| %
% Add Selected _b

m
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Click the Add Selected button 4 and click the Finish button .

Save the model with a new name, busbar_box_I.mph.

G Click the Wireframe rendering & button in the Graphics window toolbar to

look inside of the box.

©

e s-laaqe@ -kl o[0eai||C) @ @m=5

Now that you have added fluid flow to the model, you need to couple the heat
transfer part of the Joule Heating Physics Interface to the fluid flow.

G In the Model Builder, right-click Joule Heating. In the first section of the
context menu, select Heat Transfer>Heat Transfer in Fluids.

4 loule Heatinn (ih

5 Jould *5 | Joule Heating Model
57 Elect *5  Electromagnetic Heat Source
50 The 5% Iniial Values

o

“5° Heat Transfer in Solids

Elect
% ]n?tia | Heat Transfer 3
@ Heat Electric Currents 3
FVEle 4\ periodic Condition

| "5 Heat Transfer in Fluids

“I7 Heat Source
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c The Settings window for Heat
Transfer in Fluids should now be

active. Make sure this is the case.

c In the Graphics window select
the air domain to highlight it (in
red) and right-click to add it to
the Selection list (which changes
the color to blue).

Cross-check: Domain |.

Now couple fluid flow with heat
transfer.
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% Heat Transfer in Fluids

Domains

Selection: ’ Manual




In the Settings window, locate the
" Velocity field list. In the list, select

Velocity field (spf/fpl).

This identifies the flow field from the
Laminar Flow Physics Interface and couples

it to heat transfer.

Moving on to the boundary conditions,
specify the inlet and outlet for the heat

transfer in the fluid domain.

In the Model Builder, right-click Joule
" Heating. In the second section of the context menu, the boundary section,

select Heat Transfer>Temperature.

4 | oy Joule Heatipn ikl

#i Settings

% Heat Transfer in Fluids

Domains

Selection: ’Manual

1 %, o
+ Model Inputs
Absclute pressure:
P User defined -
1[atm] Pa
Velocity field:
u User defined -
User defined
a ¥ s

0

AT

JouleH| ™
Electron #
Therma =+
Electric
Initial V'
Heat FI
Electric|
Ground
Heat Tr

AT AV AV JAT JAT
AT AT

AT AV AT

Joule Heating Model

Electromagnetic Heat Source

Initial Values
Heat Transfer

Electric Currents

Periodic Condition

Heat Transfer

m
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In the Graphics window,
click the inlet boundary,
boundary number 2, and
right-click to add it to the
Selection list in the Settings
window.

This sets the inlet temperature to
293 K, the default setting.

Continue with the outlet.

©

o

In the Model Builder,

[ 9

right-click Joule Heating. In the second section of the context menu, select

Heat Transfer>Outflow.

4 (& Joule Hleatipa il
5 JouleH &
57 Electron ot |
5 Thermd =
5 Electric a
57 Initial V
[ Heat FI
50 Electric| .
5 Ground Q

Joule Heating Model
Electromagnetic Heat Source
Initial Values

Heat Transfer

Electric Currents

Periodic Condition

©

5 Heat Tr|

Heat Transfer

In the Graphics window,

click the outlet boundary,
boundary number 5, and
right-click to add it to the

Selection list in the Settings

window.
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The settings for the busbar, bolts, and for the Electric Potential | and
Ground | boundaries have retained the correct selection, even though you
added the box geometry for the air domain. To see this, click Electric
Potential | and then Ground | in the Model Builder to verify that they have
the correct boundary selection.

Continuing with the settings for the flow, you need to indicate that fluid flow only
takes place in the fluid domain. Then you need to set the inlet, outlet, and symmetry
conditions.

w

In the Model Builder, click
Laminar Flow. In the Settings

i3 Settings =0

i ) ‘ E Laminar Flow
window, locate the Selection list

. . « Interface Identifier
and click the Clear Selection

Identifier spf

button .
Domains
Selection: [Manual v]
T P
M =

In the Graphics window, click
the air box (domain number I)
and right-click to add it to the
Selection list.

You can also verify that Air in Materials has all the properties that this
multiphysics combination requires. In the Model Builder, in Materials, click Air.
In the Settings window's Material Contents list, verify that there are no missing
properties, which would be marked by a stop sign @.
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Continue with the boundaries.

G In the Model Builder, right-click G St sett @-o
Laminar Flow. From the context 51 Inlet

menu’s second section, select
Inlet. This opens the Settings
window.

Boundaries
Selection: | Manual -
2 A

e

+ Boundary Condition

Boundary condition:

Velocity -

@ MNormal inflow velocity

() Velocity field
Ug  Vin G' mis

G In the Graphics window, select
the inlet boundary and
right-click to add it to the
Selection list.

Cross-check: Boundary 2.

G Go back to the Settings window. In the Uj field, type Vin to set the Normal
“inflow velocity.
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Right-click Laminar Flow and
9 select Outlet.

In the Graphics window,
Y select the outlet boundary
and right-click.

Cross-check: Boundary 5. W

The last step is to add symmetry
boundaries. You can assume that
the flow just outside of the faces of
the channel is similar to the flow
just inside these faces. This is
correctly expressed by the
symmetry condition.

Right-click Laminar Flow and

N select Symmetry.

In the Graphics window, click

%’ Gne of the blue faces in the
figure and right-click to add it to
the Selection list. Continue with
the three other faces.

Cross-check: Boundaries |, 3, 4
and 48.

The next step is to change the mesh
slightly in order to get a quick solution.
The current mesh settings would take a

a E—_ Laminar Flow (spf)

Wall1
| Initial Values 1
Inletl
1 8 Mesh1
I 2 Studyl

- [ Results W

AT JAT AV JAT

a E—_ Laminar Flow (spf)

| Fluid Properties| ©

AT A AT

T | FAW| CAW

Fluid Properties
Volume Force

Initial Values

Inlet
Outlet

AT

AT

Wall1
| Initial Values 1
57 Inlet1
1 8 Mesh1
I 2 Studyl
[ Results

AT

| Fluid Properties|

7| FAW| CAW AW AW

AT A AT

Fluid Properties
Volume Force

Initial Values

Inlet
Outlet
Wall
Symmetry

relatively long time to solve, and you can always refine it later. So for now, make the

mesh coarser.
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COARSENING THE MESH

G Go to the Model Builder, in Mesh |, and 4 & Mesh1

. . A3 > Size
]
click Size. A% > Free Tetrahedral 1

G In the Settings window, click the
Predefined button to use the Normal

#i Settings

element size. )
43 Size

Element Size

MNormal -

) Custom

c Click the Build All button

You can assume that the flow velocity is large enough to neglect the influence of the
temperature increase in the flow field. It follows that you can solve for the flow field
first and subsequently solve for the temperature using the results from the flow field
as input. You can implement this by running a Study Sequence.

RUNNING A STUDY SEQUENCE—FLUID FLOW AND JOULE
HEATING

Solving the flow field first and then the temperature field yields a weakly coupled
multiphysics problem. The Study sequence below solves such a weak coupling
automatically.

0 In the Model Builder, = |[Compute
right-click the Study | +123 | parametric Sweep
node and select Study Steps »| *|= Stationary
Stationary to add a & Rename F2 | 'l | TimeDependent

Eigenfrequency

second stationary study
step.

Next you need to connect the correct physics with the correct study step. Start by
removing Joule heating from the first step.
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Under Study |, click the Stationary | 4 & Studyl
|7 Step 1: Stationary 1 G
|7 Step 2: Stationary
> [Fr. Solver Configurations

node.

In the Settings window, under Physics + Physics Selection

Selection, select the Joule heating (jh) Physics interfaces:

interface in the Physics interfaces list. 6 Joule heating (jh)
. . Laminar flow (spf)
Clear the Use in this study check box.

Remove the fluid flow from the second
step. 9 [ Use in this study

Under Study |, click the Stationary 2 « Physics Selection
node. In the Settings window, under Physics interfaces:

Physics Selection, select Laminar flow G Jouleheatini i'hl

(spf) from the Physics interface list and

clear the Use in this study check box.

Save the model with Ctrl-s. G [C] Use in this study
Right-click Solver Configurations and 4 @ Studyl
|7 Step1: Stationary 1
select Delete Solvers. = Step 2 Stationary 9

Thi | | i that b » [Fra Solver Configurations

IS clears any solver settings that may be 4 (5 Results L | Clear Solutions

kept from last solution. » i Datadetd e Delete Solvers
E Peried

Right-click the Study | node and select
Compute = to automatically create a new solver sequence that solves the
two problems in sequence. The simulation takes a few minutes to run.

After the solution is complete, click the Transparency button 1 on the
Graphics toolbar to visualize the temperature field inside the box

o

(dl Graphics I 0o = v| Q A

o @ vz | @ O[0me €. @ m=0)

The plot shows that the temperature in the busbar has decreased slightly compared
to the model without fluid flow. Even for this moderate flow field, the effective heat

transfer coefficient seems to be larger than the value of htc used in the previous

model.
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You can also see that the temperature field is not smooth due to the relatively coarse

mesh. A good strategy to get a smoother solution would be to refine the mesh to
estimate the accuracy.

288 DA L@ FA b HERLBEISE

I Model Builder )7 Settings >/ & = O)(cb Grophics Q Q&[4 ke
4 ¥% busbar_box_Lmph (root)
4 E Global Definitions ESurtace

T
" Parmetes
4 U0 Busbar (modl)
. = Detniions oot
b A Geometry1
» @ Materials

b am Joule Heating (jh) ~ Expression N
» E Laminar Flow (spf)
> E s —
4 @ Studyl T
{7 Step 1: Stationary 1 Unit:
|7 Step 2: Stationary [K—v]
4 Ty, Solver Configurati
» F&] solver1 Description:
- R
e
o
4 {3 3D Plot Group 1 ~ Coloring and Style
[ Color legend
[ Wireframe
A= o v 2905
R

(1 Messages (= Progress =8

Finished

‘

Working set: 943 MB Virtual memory: 1110 MB
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Often you are interested in more than a single instance of your design. Rather; you
need to design it to meet certain constraints. For the busbar a design goal could be
to lower the operating temperature. Decreasing the current density would achieve
this. Since the current density depends on the geometry of the busbar, varying the
width, wbb, should change the current density and, in turn, have some impact on the
operating temperature. Study this by running a parametric sweep on wbb.

Load the file busbar.mph and add a parametric sweep to Study |.

ADDING A PARAMETRIC SWEEP

In the Model Builder, right-click the Study | node and select Parametric Sweep.

G In the parametric sweep settings, clickthe (% settings @ =0
Add button 4 and select the Parameter % Parametric Sweep
name, wbb.

« Study Settings

Parameter names:

whbb

O
8 %[+ [2)

Parameter values: ' range(5e-2,1e-21e-1) i)

G Try range(5e-2,1e-2,1e-1) as Parameter values. This will sweep the width
of the busbar from 5 cm to 10 cm with | cm increments.

Create an Average Model Coupling, which you can later use to calculate the average
temperature in the busbar.
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9 Right-click Definitions and select Model
Couplings>Average. In the Settings
window, select All domains in the
Selection list. This creates an operator
called aveop1.

The aveop1 is now available to calculate the
average of any quantity defined on those domains.
A little later you will use it to calculate the average
temperature, but it could just as simply be used to
calculate average electric potential, current density,
etc.

Run the sweep by right-clicking the Study | node
in the Model Builder and selecting Compute =.

Save the model as busbar_III.mph.

#i Settings @ =0

%, Average
« Operator Name
Operator name:  aveopl

Source Selection

Geometric entity level:
Selection: All domains -

o = o e
)
b4

The results show the temperature in the busbar for the last parameter value, wbb=10
cm. Compare this to the temperature for wob= 5 cm.

Click 3D Plot Group | in the Model Builder.

In the Settings window, select Solution 2 in the Data set list. This data set contains

the results from the parametric sweep.

In the Parameters value list, select 0.05. Click the Plot button .4.

The maximum temperature decreases from 33| K to 318 K as the width of the

busbar increases from 5 cm to 10 cm.

A3761

37611

375

v 375

43809

389.9

388.5

v 3885

To further analyze these results, you can plot the average temperature for each

width.
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VIEWING THE RESULTS

Right-click Results and select | D Plot Group. In the Model Builder, right-click 1D Plot
Group 3 and select Global.

a In the Settings window, select 9
Solution 2 in the Data set list.
%74 Settings né =8
i, Global L
~ Data

a Data set: Solution 2 -

Parameter values:

m

~ Expressions = B~

‘ Expression

0 Click the first row in the Expressions
list and type aveop1(T). You use a similar syntax to calculate the average of

other quantities.
9 Click the Plot button .4.
Save the model.

Note that the average temperature also decreases as the width increases. This
indicates that the goal of a lower operating temperature would be fulfilled by using
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a wider busbar. Of course, this may also increase the total mass (and therefore the
cost) of the busbar. This suggests an optimization problem for you to consider.

— aveop1(T)

Average Temperature [K]
hd bt
3 @

w
=

32

0.05 0.06 007 0.08 0.09 01
Width [m]

The subject of parameter sweeps naturally raises the question of parallel processing;
it would be efficient if all parameters were solved simultaneously.

COMSOL supports most forms of parallel computing including shared memory
parallelism (for example, multicore processors) and high performance computing
(HPC) clusters.

You can use clusters to solve a series of parameter steps for a model, one parameter
per node, or you can solve a single large model using distributed memory. For
maximum performance, the COMSOL cluster implementation can utilize
shared-memory multicore processing on each node in combination with the
MPI-based distributed memory model. This brings a major performance boost by
making the most out of the computational power installed.
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ADDING A CLUSTER COMPUTING JOB

0 To run cluster 0

simulations, select Show

. . "7 Model Builder ¥ =0)
more options in the 4 ¥ busbar.mph (root) Show Name Only
View menu. b @ Global Definitions @  Show Name and Identifier
a4 v Modell (modl) Show N 4T
; = Definitions owiiameand fag
b ,E\ Geometry 1 Show Type and Identifier
i 8 Materials Show Type and Tag
4 o Joule Heating (jh) . )
57 Joule Heating Model 1 EhowlEquationlii=n
] Electromagnetic Heat ¥ Show More Options
5 Thermal Insulation 1 L
G In the Model Builder, 4 & Study1
: . . 7~ Step1: Stationary 1
right-click Study |>Job Configurations I Step v

i+ [fre Solver Configurations

Joh Canfinurati

a (5 Resul @ Show Default Solver
## Dy

L Vi

825 D, Batch

B Ta* 3\5 Cluster Computing

[T

and select Cluster Computing.

[

Parametric

The settings window helps to manage the simulation either for running several
instances of an identical parameterized model — one parameter value per host — or
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for running one parameter step in distributed mode. You choose which type of
cluster job you want to do in the Cluster type list.

T Model Builder

= =B

4 '3 bushar.mph (root)
= Global Definitions

4 W) Modell (modl)

» = Definitions

> WA Geometry1

. @8 Materials
Joule Heating (jh)
57 Joule Heating Model 1

R

A

Thermal Insulation 1
Electric Insulation 1
Initial Values 1
Heat Flux1
Electric Potential 1
Ground 1
o B3 Mesh1
4 &3 Studyl
|7 Step1: Stationary 1
> [Fr. Solver Configurations
Job Configurations
% Cluster Computing 1
- Batch1
4 g1 Results
- i Data Sets
=l Views
5% Derived Values
HH Tables
. i1 3D Plot Group 1

AT AT AV JAT

AT AT

Electromagnetic Heat Sourcel

#i Settings

% Cluster Computing
« General

Prepend command:

Postpend command:

Batch job: [Batch1

)

* Cluster Settings

Cluster type:
MNumber of nodes:
MNode granularity:
[¥] Exclusive nodes

Advanced
Scheduler:
Requested nodes:
Cores per node:
Memory per node (MB):
Runtime {minutes):
User:

Priority:

HPC5 2008 -

50

localhost
8

32000

Infinite

MNormal -

COMSOL supports Windows Compute Cluster Server 2003, Windows HPC Server
2008, and Linux. To learn more about running COMSOL in parallel, see the
Installation and Operations Guide.
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This section contains details and some depth regarding the creation of the busbar
geometry using COMSOL's geometry tools. The step-by-step instructions will lead
you through the construction of the geometry using parameters set up in Global
Definitions. Using parameterized dimensions aids in the execution of what-if analyses
and automatic geometric parametric sweeps.

If you have not yet done so, follow the steps under the Model Wizard and Global
Definitions from the “Thorough Example: The Busbar” section, starting on page 7.
Then return here for the geometry modeling.

Drawing the profile of the busbar is the first step in the geometry sequence.

Right-click Geometry | and select Work
Plane. In the Settings window, select

, , #i* Settings FEHAE-E
xz-plane from the Plane list. Click the Show || _
) £ Work Plane
Work Plane button & on the Settings
. " . . ~ Work Pla
toolbar. Continue editing the axis and grid ererane
. . Plane type:
settings in Work Plane |. -
’QUICk v]
Plane:
’xz-plane v]
y-coordinate:
0 m
3D projection:
Entire 30 geometry -

xz-plane
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In the Model Builder, expand the View 2 node and click Axis. Enter the values
below into the Axis and Grid settings fields and select the Manual Spacing
check box. Leave the Extra X and Y fields blank. Click the Apply button ¢ .

T Model Builder 7 = B[4 Settings ¢ & =8
4 % Untitled.mph (root) =
4 = Global Definitions 1 Axis
Pi Parameters ~ Axis

4 A Modell (modl)
> = Definitions Xmin: -le-2
4 ;’-’\ Geometry 1

> Kmax 011
a /5 Work Plane 1 (wpl) e
. J’\ Geometry ¥ min: -le-2
4 E:‘{f"“’z Y¥mae 011
.
ﬂ - Form U:ion (fin) Preserve aspect ratio
# Materials * Grid
o= Joule Heating (jh)
5 Mesh1 Extra X:
&3 Studyl Extra ¥:
W Results Manual spacing
X|spacing: 5e-3
Y|spacing:  5e-3]
2D Axis Select Manual Spacing
You can use interactive drawing to Draw Line  Draw Quadratic
create a geometry using the
drawing toolbar buttons while 0=B8 58 ed L4~ |[LrrO@
pointing and clicking in the ‘I Model Builder 7 7 0| settings
. . 3 Untitled.mph (root)
Graphics window. You can also '+ ® Global Definitions A Geometry
right-click the Geometry node in Pi Parameters
4 A Modell (modl)
the Work Plane | tree to add . = Definitions
geometric objects to the geometry 4 A\ Geometry1
a /5 Work Plane 1 (wpl)
sequence. > \F\ Geometry
4 [ view2
In the next series of steps, you will <L~ Auis
Form Union (fi
create a profile of the busbar. ¥4 > Form Union (fin)
# Materials
* amm Joule Heating (jh)
53 Mesh1
» s Studyl
- I51 Results
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In the Model Builder>Work Plane |,
right-click Geometry and select
Rectangle. Type L+2*tbb in the Width
edit field and 0.1 in the Height edit
field. Click Build Selected .

Create a second rectangle. In the
Model Builder>Work Plane |,
right-click Geometry and select
Rectangle. Type L+tbb in the Width
edit field, 0.1-tbb in the Height edit
field, and tbb in the y position edit field.
Click Build Selected .

Use the Boolean Difference operation
to subtract the second rectangle from
the first one. In the Model
Builder>Work Plane I, right-click
Geometry and select Boolean
Operations>Difference.

#i* Settings i @ =0
— Rectangle
* Object Type
Type: ’Solid -
- Size
Width:  L+2*tbb m
Height: 0.1 m
~ Position
Base: | Corner -

X 0 m
y: 0 m
#i* Settings @ =0

— Rectangle
* Object Type
Type: ’Solid -
- Size
Width:  L+tbb m
Height: 0.1-thb m
~ Position
Base: | Corner -
X 0 m
y: thb m
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In the Graphics window, click r1 and

right-click to add r1 to the Objects to it Settings EEIQ-o
add list. Click the Activate selection .
button ¢ in the Objects to subtract —
list. Right-click to add r2 to the Objects to add:
Objects to subtract list. Click Build o o
Selected . You should now have a +
backward-facing, L-shaped profile. =
Continue by rounding the corners ®
using fillets.

Objects to subtract

i

ES

In the Model Builder>Work Plane |, it Settings &
right-click Geometry and select Fillet. @ Fillot

In the Graphics window, click point 3,
the inner corner, and right-click to add
it to the Vertices to fillet list. Type tbb

 Points

Vertices to fillet:

difl S
in the Radius edit field. This takes care 3 o
of the inner corner. b4
+ Radius
Radius: thb m
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For the outer corner, right-click
Geometry and select Fillet. In the
Graphics window, click point 6, the outer
corner; and right-click to add it to the
Vertices to fillet list. Type 2*tbb in the
Radius edit field. Click Build Selected .

The resulting profile should look like below.

0105
01
0095
009
0085
008
0075
007
0065
006
0055
005
0045
004
0035
003
0025
002
0015
001
0005
0
0,005

| 0
T 3

004 003 002 001 0 001 002 003 004 005 006 007 008 009 01 011 012 013 014

| 7% Settings - . il

# Fillet

 Points

Vertices to fillet:

fill
6

X0+

« Radius

Radius: 2*tbb m

Next you extrude the Work Plane to create the 3D busbar geometry.

In the Model Builder, right-click Work
Plane | and select Extrude. In the Settings
window, enter wbb in the Distances table
to extrude to the width of the profile.
Note that the Distances table allows you
to enter several values in order to create
sandwich structures with different layer
materials. In this case, only one extruded
layer is needed.

#i* Settings
& Extrude =
~ General

Work plane: | wpl -

Input objects:

fwpl

X0 =+

m

[[] Keep input objects
Keep cross-sectional faces

« Distances from Work Plane

Distances (m)
whb
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Click the Build Selected § and Zoom Extents [# buttons. Click the Save button
and save the model as busbar.mph. The root node has the same name as your file.

Root Node Build Selected Zoom Extents

5 busbarmph - COMSOL Multphysics [BEISS)

Fie Edt Optiors Help Develop

o setings B 1@ = O)(ch Grphics _ S0
& Extrude IHe®-|QQRe@| -z g@oaan|@ue

~ General

Input objects:

Buld Preceding Stste

[ Reverse directon

» Scales
» Displacements
» Toist Angles

 Polygon Resolution of Edges.

£ Messages 52 = Progress| (-] Resuts| =0
consoL 400325

[ Woringc 44 Vit oy 14

Next, create the titanium bolts by extruding two circles drawn in two work planes.

In the Model Builder, right-click Geometry | and select Work Plane. In the
Settings window, under Work Plane 2, select Face parallel as the Plane type.

7 Model Builder ¥ = O[3 Settings E |
4 V3 bushar.mph (root)
4 E Global Definitions — || & Work Plane
Pi Parameters
' Model1 (modl)
- = Definitions Plane type:
4 “E\ Geometry 1 Face parallel v]
4 E’ Work Plane 1 (wpl)
4 A\ Geometry
[ Rectanglel (r1) extl
1 Rectangle 2 (r2) 8
(2 Difference 1 (dif1)
il Fillet1 (fitz)
Fillet 2 (fil2)
a4 L~ View2
wla Axis
Extrude (extl)
4 E’ Work Plane 2 (wp2)
& Geometry
i onl View 3

[@==

»

~ Work Plane

[

Planar face:

x 1 +[c]

Origin:

m

Center of face -
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In the Graphics window, click the face
highlighted in the figure. Once this
surface is highlighted red, right-click
anywhere in the Graphics window to
add it to the Planar face list in the
Settings window.

Face number 8 is highlighted in blue and
the work plane is now positioned on

top of face number 8.

Click the Show Work Plane button &

to draw the first circle representing the Face 8
position of the first bolt. Click the
Zoom Extents button .
Under Work Plane 2, right-click pP— BEREa-o
Geometry and select Circle. In the =
i ) i ] () Circle
Settings window, define a circle with
. « Object Type
radius rad_1 and the center :
coordinates (0, 0). Click the Build = ol M
Selected button . The geometry -
should look according to the figure. Radius: | rad 1 m
~ Paosition
Base: | Center -
e 0 m
y: 0 m
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Continue by creating the bolt using an extrude operation. In the Model
Builder, right-click Work Plane 2 and select Extrude. In the Settings window,
in first row of the Distances table, enter -2*tbb to extrude the circle a
distance equal to the thickness of the busbar

T Model Builder ¥ = B[ Settings i
3 busbar.mph (root) - Ext
- rude

= Global Definitions %
Fi Parameters « General

A Modell (modl)
= Definitions Work plane: [wsﬂ ']
*E\ Geometry 1 Input objects:

5 Work Plane1 (wpl)
WA, Geometry wp2 | &

{1 Rectanglel (v1)
I Rectangle 2 (r2)
[ Difference (dif1)
il Fillet1 (fitz)
Fillet 2 (fil2)
w]» View 2
wla Axis
&0 Extrudel (extl)
Work Plane 2 (wp2)
A\ Geometry ~ Distances from Work Plane
<]~ View 3
& Extrude 2 (ext2) Distances (m)
#A, Form Union (fin) -2*tbb
# Materials
- Joule Heating (jh)
58 Mesh1

[[] Keep input objects
Keep cross-sectional faces

m

Click the Build Selected button j to
create the cylindrical part of the titanium
bolt that runs through the busbar

Draw the two remaining bolts.
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Right-click Geometry | (in Model I)
and select Work Plane. In the Settings
window, under Work Plane, select
Face parallel as the Plane type. In the
Graphics window, click the face shown
in the figure. When this surface is
highlighted red, right-click anywhere in
the Graphics window to add it to the
Planar face list in the Settings window.
Face number 4 should now be
highlighted in blue.

Click the Show Work Plane button &.

Face 4

Click the Zoom Extents button [ to get a better view of the geometry. To
parameterize the position of the two remaining bolts, add the circles that

form the cross sections of the bolts.

Under Work Plane 3, right-click
Geometry and select Circle. In the
Settings window, enter rad_1 in the
Radius field, -L/2+1.5e-2 in the x
edit field, and -wbb/4 in the y edit
field in the Position section.

Click the Build Selected button .

#i¢ Settings @EE=o
Circle
* Object Type
Type: ’Solid -
- Size
Radius: rad_1 m
~ Position
Base: | Center -
e -L/2+1.5e-2 m
¥ -whb/4 m
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Copy the circle that you just created 7t Settings ARA&=-o
to generate the third bolt in the &1 Copy

busbar. Under Work Plane 3, -

right-click Geometry and select —
Transforms>Copy. In the Graphics 5 e
window, click the circle ¢1 to -
highlight it. Right-click anywhere in b
the Graphics window and add the [ Keep input objects

circle to the Input object list in the o [ T

Settings window. In the Settings i B
window, under Displacement, enter v whby2 m

wbb/2 in the y field.
Click the Build Selected button .

The geometry should look like this. Continue by extruding the circleS.

0.0z

0.01
-0.01 @

-0.02

-005 -004 -003 -002 -001 0 001 002 003 0.04 005 0.08

In the Model Builder, right-click Work Plane 3 and select Extrude. In the
Settings window, in the first row of the Distances table, enter -2*tbb. Click
the Build Selected button . The geometry and its corresponding geometry
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sequence should look like this. Click the Save button g and save the model as
busbar.mph.

4 A Geometry 1
a E’ Work Plane 1 (wpl)
4 A Geometry
1 Rectanglel (rl)
1 Rectangle 2 (r2)
(3 Difference (difl)
il Fillet 1 (fil1)
il Fillet 2 (il2)
[ nla View 2
& Bxtrudel (extl)
a E’ Work Plane 2 (wp2)
4 A Geometry
[ circle1 (c1)
[ nla View3
& Bxtrude 2 (extd)
m a E’ Work Plane 3 (wp3)
4 A Geometry
D Circlel (i) 4]
[&] Copy1 feopy1)
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Torquing a Wrench

Working with hand tools gives you a practical introduction to basics of engineering.
In all likelihood, you have tightened a bolt using a wrench at some point in your life.
This exercise will take you through a model that will analyze this very basic task, going
into deeper details including associated geometric tolerances, torque specs, and the
intrinsic contact problem.

In principle, a bolt replaces the need for external fastening by providing an internal
clamping force via pretension. The tensile stress in a bolt is produced when it is

torqued into a matching threaded hole or nut. The magnitude of this stress depends
on many factors such as material selection, assembly configuration, and lubrication.

Control of these parameters, in turn, becomes the focus of much engineering effort,
especially in critical applications such as automotive engines, brakes, aircraft, and
structural installations. The following model presents both a bolt and a wrench at the
moment of installation.

Go to the Model Wizard window and

. ¥3 Model Wizard & =d
click Next.
Select Space
Dimension 2 #

@ 3D
() 2D axisymmetric
@2
() 1D axisymmetric
©1D
JoD
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In Add Physics tree, select Structural
Mechanics > Solid Mechanics (solid).

Click Next.

In the Studies, select Preset Studies >
Stationary.

Click Finish.

13 Model Wizard =08
Add Physics EER |
1+ £]i Acoustics -

[» 4# Chemical Species Transport
i+ I Electrochemistry —
[» 4% Fluid Flow
[> 11} Heat Transfer
i @ Plasma
I g5 Radie Frequency
4 % Structural Mechanics
[5} Solid Mechanics (solid)
ﬁ Thermal Stress (ts)
7 Poroelasticity (poro)

m

13 Model Wizard =08
Select Study Type @
Studies

4 (&% Preset Studies

|l Eigenfrequency

(WY Frequency Domain

[l Frequency Domain Modal

|5 Linear Buckling

|7 Stationary

[, Time Dependent

[, Time-Dependent Madal
I+ &= Custom Studies
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In the Model | branch, right-click

Geometry | and left-click Import to
select it.

7 Model Builder ¥ =0
4 '3 Untitled.mph (root)
= Global Definitions
4 W) Modell (modl)
> = Definitions
1 ¥ Geometryl

88 Materials | ] Build Al
b [ Solid Mech
£ Meshl | © Import
[ s Studyl
1> {1 Results Elesk
Cone
0 Cylinder
“{) Sphere
Locate the Geometry import: drop down Settings i =5
list and select 3D CAD file. —
= Import
« Import
Geometry import:
30 cap e -
Filename:
CACOMSOL Multiphysics\Models\wrench.x
---- |

Click Browse and locate the file wrench.mphbin in the Model Library folder
COMSOL_Multiphysics/Structural_Mechanics.

Click the Import button, which results in the display of the geometry in the
Graphics window.
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i lo®-aaQamel L -hixk gfomaRC). B/m-0

MATERIALS

The chosen bolt material and tool steel are important characteristics of this contact
problem. Here is how to choose them in COMSOL.

n In the Model | branch, == O (s settings
mght-;hck Materials ahd a ﬁgr;tdb:xémim & Materials
left-click Open Material + 8 Model1 fmod]) _—
Browser. b = Definitions

4 A Geometry 1

& Import1 (impl)
Form Union (fin) 0
& Materials
p 2] Solid Meg * &8 Material
i £ Mesh1 [ &  Open Material Browser
b @3 Studyl
» () Results [l Dynamic Help A

™

Easy Example: The Wrench | 77



@ Locate the Material Selection
section, expand the Built-In
folder, find Structural Steel, and
left-click Add Material to
Model.

6 Observe how COMSOL
categorizes available
material information with
respect to what the
currently active physics
requires.
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#2¢ Settings | % Material Browser 52

=08

Ox|+|@

Material Browser

Materials

# Nimonic alloy 90
#E Nylon

&8 Silica glass

# Silicon

#E Polysilicon

#8 Solder, 605n-40Pb
#B Steel AISI4340

#8 Structural steel

#8 Lead Zirconate Titanate (PZT-

2}

-

¢l Graphics

# Tungsten

v o Remove Selected

&8 Titanium be & Add Material to Model

#i Settings

& Material

Geometric Scope

Geometric entity level: ’ Domain

g

Selection: ’AI.I. domains

)

1
2

« Material Contents

X0 =+

| Property | MName | Value |:
~" Density rtho 7850..."3]
+~ Young's modulus E 200e9[Pa]
~" Poisson's ratio nu 033 =
Relative permeability mur 1
Heat capacity a...stant pressure  Cp 475[..7K]]
Thermal conductivity k 44.5..7K]]
Electric conductivity sigma  4.03../m]
Relative permittivity epsilonr 1
Coefficient of ...rmal expansion alpha  12.3../K]
Murnaghan thir...lastic meduli | -3.0..[Pa]

< 1




With the geometry and materials defined, you are now ready to revisit the governing

physics introduced in the Model Wizard section.
In the Model Builder

7 Model Builder

window, right-click 4 V3 Untitled.mph (root)

Solid Mechanics (solid) B Global Defintions
) ) a4 v Modell (modl)

and left-click Fixed . = Definitions

Constraint to select it. 4 /A Geometry1

& Import1 (impl)
[&# Form Union (fin)

a4 #B Materials

. @8 Structural steel

= T B || Settings
{2} Solid Mechanic
« Interface Identifier
Identifier:  solid

Domains

Selection: | All domains

- |[&} Solid Mechanics (solid) !

» €58 Mesh1
» s Studyl
- [g1 Results

Rotate the geometry

by left-clicking and dragging into
the position shown. Then left-click
the cut-face of the partially
modeled bolt (which turns the
boundary red) and right-click to
select it (which turns the boundary
blue).

Cross-check: Boundary 35.

AT AT ¥| FAT AT AT AT

AT | AW | CAW

AT

Linear Elastic Material Model

Hyperelastic Material Model

Viscoelastic Material Model

Elastoplastic Material Model

Geomechanics Material Model

Body Load |
Perfectly Matched Layers i
Initial Values

More 3

Free

Fixed Constraint

Prezcribed Displacement
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Left-click the Go to Default 3D View button to restore the earlier view.

-

(d'm Graphics

EMe =~ & @

Bl -bzklg o(daar||C) @ m=0|

Then use the Zoom Box button to prepare the view shown in |0.

In the Model Builder
window, right-click
Solid Mechanics (solid)
and left-click Boundary
Load to select it.
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7 Model Builder

#i? Settings

4 13 Untitled.mph (root)
= Global Definitions
4 W) Modell (modl)
= Definitions
4 A Geometryl
& Import1 (impl)

a4 #B Materials
[ @8 Structural steel
4[5 Solid Mechanics (solid)

{2} Solid Mechanic
« Interface Identifier
Identifier:  solid

Domains

Selection: | All domains
1

57 Linear Elasti +I5

5 Freel v

57 Initial Value|

1 Fixed Const|

 E58 Meshl +8

[ s Studyl +
i+ i) Results E
£

£

5

5

5

5

5

5

5

5

o +

Linear Elastic Material Model
Hyperelastic Material Model
Viscoelastic Material Model
Elastoplastic Material Model
Geomechanics Material Model
Body Load

Perfectly Matched Layers
Initial Values

More 3

Free

Fixed Constraint
Prescribed Displacement
Prescribed Velocity
Prescribed Acceleration
Symmetry
Antisymmetry

Roller

Boundary Load

Periodic Condition



G Rotate the geometry by left-clicking
and dragging into the position
shown. Then select the top socket G
face by left-clicking to highlight the
boundary and right-clicking it to add
it to the list.

Cross-check: Boundary |1 1.

e In the corresponding Settings 2t Settings @=o
window, choos.e the Load type: Totall R Boundary.Load
force and specify -150 N. The negative ,
sign indicates the negative Z direction or
. Selection: ’Manual v]
simply downward.
111 % 4
B =
=
| Coordinate System Selection
Coordinate system:
Global coordinate system -
|~ Force
Load type:
Total force -
Total force:
1] X
F o G ¥ | N
_-150] E
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MESH

COMSOL uses finite elements to find the displacement and stress fields.

G In the Model Builder window, right-click (- \iodel Builder =g

Mesh | and left-click Free Tetrahedral to 4 V3 Untitled.mph (root)
= Global Definitions
4 W) Modell (modl)
> = Definitions
F\ Geometry 1
& Import1 (impl)
7 Form Union (fin)
a4 #B Materials
[ @8 Structural steel
4 [5] Solid Mechanics (solid)
Linear Elastic Material Model 1
Freel
Initial Values 1
Fixed Constraint 1
Boundary Load 1
» [E8 Mesh1
b €3 Studyl Build Al
[ Results

select it.

AT

AT JAT AT

* 4% Free Tetrahedral
"’ff[”1 Swept

G In the Settings window, click the Build All button

s

2k

i 0" 4.-

A
"";‘"VA"": i

Ol ﬂ

e A v.».v

o :ﬂ,:.m ¥
o
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STUDY

0 Right-click the Study | branch and 7 Model Builder =g

left-click Compute to select it. 4 V3 Untitled.mph (root)
= Global Definitions
4 W) Modell (modl)
> = Definitions
4 A Geometryl
& Import1 (impl)
Form Union (fin)
a4 #B Materials
[ @8 Structural steel
4 [5] Solid Mechanics (solid)
57 Linear Elastic Material Model 1
Freel
Initial Values 1
Fixed Constraint 1
Boundary Load 1
4 5 Mesh1l

..'..L.‘.E Size

£ Free Tetrahedral 1 0

I+ &2 Study 1
3 Results | = Compute

A

AT JAT AT

DISPLAY RESULTS

COMSOL finishes after about one minute of computation time and displays the
displacement field by default. To determine the location of greatest tension, plot the
principal stress field s|.

Easy Example: The Wrench | 83



Right-click the Results
branch and left-click 3D
Plot Group.

o

Right-click the 3D Plot
Group 3 just added and
left-click Contour to

2]

select it.
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7 Model Builder
4 13 Untitled.mph (root)
= Global Definitions
4 W) Modell (modl)
> = Definitions
4 A Geometryl
& Import1 (impl)
Form Union (fin)
a4 #B Materials
[ @8 Structural steel
f5} Solid Mechanics (solid)
Linear Elastic Material Model 1
Freel
Initial Values 1
Fixed Constraint 1
Boundary Load 1
4 5 Mesh1l
..'..L.‘.E Size
£ Free Tetrahedral 1
4 &3 Studyl
|7 Step1: Stationary
i+ [fre Solver Configurations
4 Results —
. & Data “IEl 3D Plot Group
E% Deriy “ [ 2D Plot Group
FH Tabl| +1 1D Plot Group

[

AT JAT AV JAT

7 Model Builder

4 13 Untitled.mph (root) )
£ Global Definitions | =
il |

Volume

1]

Arrow Volume

a4 v Modell (modl)

L Surface
> = Definitions ]
4 A Geometryl fre
& Import1 (in Isosurface
Form Union - Arrow Surface
a4 #B Materials i
I+ &8 Structural st Line
4 [5] Solid Mechanic * | Contour
57 Linear Elasti - Streamline
|23
: Fr.e.el Arrow Line
@ Initial Value ) .
50 Fixed Const h Particle Tracing
Boundary L *45  Particle Tracing with Mass
E28 Mesh1 =
8 - es. “E  Mesh
..'...‘.E Size
Free Tetrah More Plots
4 &3 Studyl
+[
|7 Step1: Stationa 5] AddImage to Report
i+ [fre Solver Configu
Delet
a Results % .e €
|+ i Data Sets (% Disable
5% Derived Values < Rename
FH Tables .
» @@ 30 PlotGroup] & Properties
3 3D Plot Group 2 Dynamic Help
3D Plot Group 3
[ Report ﬂ



©

4

In the corresponding Settings window, click the Replace Expression button

and select Principal stresses 10 (solid.spl), which is representative of the sl

field.

~ Expression - % |
Expression: Solid Mechanics 13 Acceleration 13
soliddisp Definitions v Deformation gradient 3
Unit Geometry and Mesh » Density (solid.rho)
[ Displacement field »
= -
Elastic strain tensor, local coordinate system 3
[7] Description:
First Piola-Kirchhoff stress »
Total displacement Initial strain o
iy xlD_BD Initial stress 13
Load »
Entry method: | Number of levels - 10 Nt properties 3
Total levels: 20 MNormal vector 4
1
~ Coloring and Style MNormal vector »
z «10 Normal vectar »
Contourtype: nd = e 5
Coloring: Color table - Pressure (solid.p)
e Principal strain directions ’
@] Color legend Principal strains »
4] Messages | == Progre Principal stress directions 3
AR Principal stresses 3 First principal stress (solid.sp1)
» Inherit Style Reaction force 3 Second principal stress (solid.sp2)
— Reaction torque » Third principal stress (solid.sp3)
In the same Settings window, check it Settings | @=0
Description, change itto Principal .
P ' 2 P Contour
Stress Field S1, set the Total
« Data
levels to 12, and the Contour type

to Filled.

 Expression

Expression:
modl.solid.spl
Unit:

- %

[/m22

Description:

Principal Stress Field 51

- Levels

Entry method: | Number of levels -

Total levels: 12

w Coloring and Style

Contour type:

©

Filled -
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o Click the Plot button and rotate the geometry approximately to the
orientation shown.You can see that the tensile stress concentrates at the
handle's top toward the open end, which is consistent with the downward
force applied to the socket. Also note high stresses in the head to shank
transition of the bolt.

¥ 7
¥ -8.394x10
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After completing a design study as you have done, you often want to use the results
in some other context. For instance, you may want to output an optimal geometry
in a dedicated CAD format. In fact, the broadly applicable nature of multiphysics
simulation brings with it the need for interaction with many other scientific
computing platforms. For this reason, COMSOL Multiphysics provides the capability
to read and write a wide array of file formats. The list below contains several formats
that are compatible with COMSOL. These formats are categorized according to the
associated type of software.
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FILE FORMAT READ WRITE

SolidWorks® (:sldprt, .sldasm)’ Yes Yes®
Pro/ENGINEER® (.prt, .asm)1 Yes Yes?
Autodesk Inventor® (ipt, .iam)1 Yes Yes®
DXF (.dxf) Yes Yes
Parasolid® (:x_t, xmt_txt, .x_b, .xmt_bin)1 Yes Yes
ACIS® (sat, .sab)’ Yes No
Step (.STEP)1 Yes No
IGES (IGES)! Yes No
CATIA® V5 (.CATPart, .CATProduct)2 Yes No
VRML, vl (.vrml, .vrl) Yes No
STL (.stl) Yes No

1 Requires one of the LiveLink™ products for SolidWorks®, Pro/ENGINEER®, or
Inventor®; or the CAD Import Module

2Requires the CAD Import Module and the File Import for CATIA® V5

3o file via linked CAD package

FILE FORMAT READ WRITE
NETEX-G (asc)’ Yes No
ODB++(X) (xml)! Yes No
GDS (gdx)! Yes No
SPICE (.cis)! Yes No

1Requires one of AC/DC Module, RF Module, or MEMS Module

FILE FORMAT READ WRITE
NASA file (.dat)! Yes No
CHEMKIN (.dat)' Yes No
CAPE -OPEN! (direct connection) n/a n/a

1Requires Chemical Reaction Engineering Module




FILE FORMAT READ WRITE
NASTRAN Bulk Data (.nas, .bdf, .nastran, .dat) Yes No
VRML, vI (.vrml, .vrl) Yes No
STL (.stl) Yes No
FILE FORMAT READ WRITE
Plain text (.txt) Yes Yes
Copy and paste spreadsheet format No Yes
JPEG (jpg) No Yes
PNG (.png) No Yes
BMP (.bmp) No Yes
EPS (.eps) (2D graphs) No Yes
Animated GIF (.gif) No Yes
Adobe® Flash (.swf) No Yes
AVI (avi)! No Yes

! Available for Windows only

FILE FORMAT READ WRITE
MATLAB®: Model M-File (.m)1 Yes Yes
MATLAB®: Function (.m)" Yes No
Java: Model Java File (java) Yes Yes

C: Function Yes No
IRequires LiveLink™ for MATLAB®

FILE FORMAT READ WRITE
Spreadsheet Yes Yes
Grid Yes No
Sectionwise Yes Yes




FUNCTION

ARGUMENTS AND DEFINITION

CALL

Analytic

Gaussian Pulse

Interpolation

The function name is its identifier;
for example an1.

The function is a mathematical
expression of its arguments.

Example: Given the arguments X
and vy, its definition is
sin(x)*cos(y).

The function has arbitrary number
of arguments.

The function name is its identifier;
for example gp1.

The Gaussian pulse function defines
a bell-shaped curve according to the
expression

—(s— So)z
1 26°

e
oN2n

It is defined by the mean parameter,
so and the standard deviation, .

y(s)=

The function has one argument.

The function name is its identifier;
for example int1.

An interpolation function is defined
by a table or file containing the
values of the function in discrete
points.

The file formats are the following:
spreadsheet, grid, or sectionwise.

The function has one to three
arguments.

The name of the function with
comma-separated arguments within
parenthesis. For example:

ant(x,y)

The name of the function with a
single argument within parenthesis.
For example:

gp1(x)

The name of the function with
comma-separated arguments within
parenthesis. For example:

int1(x,y,z)
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FUNCTION

ARGUMENTS AND DEFINITION

CALL

Piecewise

Ramp

Random

Rectangle

Step

The function name is its identifier;
for example pw1.

A piecewise function is created by
splicing together several functions,
each defined on one interval. Define
the argument, extrapolation and
smoothing methods, and the
functions and their intervals.

This function has one argument with
different definitions on different
intervals, which must not overlap or
have any holes between them.

The function name is its identifier;
for example rm1.

A ramp function is a linear increase
with a user-defined slope that
begins at some specified time.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example rn1.

A random function generates white
noise with uniform or normal
distribution and has one or more
arguments to simulate white noise.

The function has arbitrary number
of arguments.

The function name is its identifier;
for example rect1.

A rectangle function is 1 in an
interval and 0 everywhere else.

The function has one argument.

The function name is its identifier;
for example step1.

A step function is a sharp transition
from 0 to some other value
(amplitude) at some location.

The function has one argument. It
can also be smoothed.

The name of the function with a
single argument within parenthesis.
For example:

pwi (x)

The name of the function with a
single argument within parenthesis.
For example:

rmi (x)

The name of the function with
comma-separated arguments within
parenthesis. For example:

rni(x,y)

The arguments x and y are used as a
random seeds for the random
function.

The name of the function with a
single argument within parenthesis.
For example:

rect1(x)

The name of the function with a
single argument within parenthesis.
For example:

step1(x)
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FUNCTION

ARGUMENTS AND DEFINITION

CALL

Triangle

Waveform

The function name is its identifier;
for example trii.

A triangle function is a linear
increase and linear decline within an
interval and 0 everywhere else.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example wv 1.

A waveform function is a periodic
function with one of several
characteristic shapes: sawtooth, sine,
square, or triangle.

The function has one argument. It
can also be smoothed.

The name of the function with a
single argument within parenthesis.
For example:

tril(x)

The name of the function with a
single argument within parenthesis.
For example:

wv1(x)
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SHORTCUT ACTION

Fl Display dynamic help for the selected node

F2 Rename the selected node, file, or folder

F8 Build the geometry, build the mesh, or update the plot
Del Delete a node

Ctrl+up arrow

Ctrl+down arrow

Ctrl+Tab
Ctrl+Shift+Tab
Ctrl+Alt+left arrow
Ctrl+Alt+right arrow
Ctrl+Alt+up arrow

Ctrl+Alt+down
arrow

Shift+F10
Ctrl+Space

Move a physics node (except default nodes), material node, mesh
node, or study step node up one step in the sequence

Move a physics node (except default nodes), material node, mesh
node, or study step node down one step in the sequence

Switch focus to the next window in the desktop

Switch focus to the previous window in the desktop

Switch focus to the Model Builder window

Switch focus to the Settings window

Switch focus to the previous section in the Settings window

Switch focus to the next section in the Settings window

Open context menu

Open list of predefined quantities for insertion in Expression edit fields

for plotting and results evaluation

Keyboard Shortcuts | 93



94 | Keyboard Shortcuts



	Introduction
	Capture the Concept
	Organize
	Customize
	Streamline

	Thorough Example: The Busbar
	Parameters, Functions, Variables, and Model Couplings
	Defining Model Couplings

	Material Properties and Libraries
	Mesh Sequences
	Adding Physics to a Model
	Structural Mechanics
	Fluid Flow

	Parameter Sweeps, Parallel Computing
	Sweeping a Geometric Parameter
	Parallel Computing

	Geometry Sequences
	Easy Example: The Wrench
	Supported External File Formats
	MCAD
	ECAD
	Material Databases
	Mesh
	Numerical Data, Images, and Movies
	Programming Languages
	Interpolation Data Formats

	Built-in Functions
	Keyboard Shortcuts

